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Create a calculated column 

1. In the PowerPivot window, select the FactSales table. 
2. On the Design tab, in the Columns group, click Add. 
3. In the formula bar above the table, type the following formula. AutoComplete helps you type the 

fully qualified names of columns and tables, and lists the functions that are available. For tips on 
how to use AutoComplete, see Building Formulas for Calculated Columns and Measures. 

=[SalesAmount] - [TotalCost] - [ReturnAmount]. 

4. When you have finished building the formula, press ENTER to accept the formula. 

Values are populated for all the rows in the calculated column. If you scroll down through the 
table, you will see that rows can have different values for this column, based on the data that is 
in each row. 

5. Rename the column by right-clicking CalculatedColumn1 and selecting Rename Column. Type 
TotalProfit, and then press ENTER. 

Important 
Always create PivotTables from the PowerPivot window or the PowerPivot tab in the Excel window. There 
is also a PivotTable button on the Insert tab in the Excel window, but standard Excel PivotTables cannot 
access your PowerPivot data. 

To Add a PivotTable to Your Analysis 

1. In the PowerPivot window, on the PowerPivot Home tab, click PivotTable. 
2. Select New Worksheet.  

Excel adds an empty PivotTable to the location you specified and displays the PowerPivot Field 
List. The Field List displays two sections: a field section at the top for adding and removing fields, 
and a section at the bottom for rearranging and repositioning fields. 

3. Select the empty PivotTable. 

If you get an error message telling you the data list is no longer valid, right-click the table and 
select Refresh Data.  

4. In the PowerPivot Field List, scroll down and locate the FactSales table. 
5. Select the SalesAmount field. Ensure this field displays in the Values window of the Field List. 
6. In the DimChannel table, select the ChannelName field. Ensure this field displays in the Row 

Labels window of the Field List. 
7. In the DimDate table, select the CalendarQuarter field. In the PivotTable Field List, move this 

field from the Values box into the Column Labels box. 
8. Rename the PivotTable by double-clicking Sum of SalesAmount in the first cell, erasing the 

current text, and typing Sales by Channel. 

http://technet.microsoft.com/en-us/library/ee835590.aspx
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9. Format the display of the data to make it easier to read and compare. Highlight the data cells, 
right-click and select Format Cells. In the Format Cells window, select Currency and make sure 
that 2 is selected in the Decimal places dropdown. Select $ for Symbol. Click OK. Change column 
widths if numbers aren’t readable. 

The Sales by Channel PivotTable lists the sum of sales for Contoso and for each Sales Channel, by 
quarters from first quarter 2007 through fourth quarter 2009. 

To Add Another PivotTable to Your Analysis 

1. In the Excel window, on the PowerPivot tab, click PivotTable. 
2. Select New Worksheet.  

Excel adds an empty PivotTable to the location you specified and displays the PowerPivot Field 
List. 

3. Select the empty PivotTable. 

If you get an error message telling you the data list is no longer valid, right-click the table and 
select Refresh Data.  

4. In the PowerPivot Field List, scroll down and locate the FactSales table. 
5. Select the TotalProfit field. Ensure this field displays in the Values window of the Field List. 
6. In the PowerPivot Field List, locate the ProductCategory table. 
7. Select the ProductCategoryName field. Ensure this field displays in the Row Labels window of 

the Field List. 
8. In the PowerPivot Field List, locate the DimDate table. 
9. Select the CalendarYear field. In the PivotTable Field List, drag this field from the Values window 

into the Column Labels window. 
10. Rename the PivotTable by double-clicking Sum of TotalProfit in the first cell, erasing the current 

text, and typing Profit by Category. 
11. Format the display of the data to make it easier to read and compare. Highlight the data cells, 

right-click and select Format Cells. In the Format Cells window, select Currency and make sure 
that 2 is selected in the Decimal places dropdown. Select $ for Symbol. Click OK. Change column 
widths if numbers are not readable. 

The Profit by Category PivotTable lists the sum of profits, by year, for each Contoso product category. 

To Delete a PivotTable 

1. Click inside the PivotTable. 
2. In the PivotTable Tools tab, select Options. 
3. In the Actions group, click Select. 
4. Select Entire PivotTable. On the Home ribbon select Delete and then click Delete Sheet. 

Important 
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Always create PivotCharts from the PowerPivot window or the PowerPivot tab in the Excel window. There 
is also a PivotChart button on the Insert tab in the Excel window, but standard Excel PivotCharts cannot 
access your PowerPivot data. 

To Add a PivotChart to Your Analysis 

1. Start on the worksheet that contains your Sales by Channel PivotTable.  
2. On the PowerPivot tab in Excel, click the arrow below PivotTable and select PivotChart. 
3. Select Existing Worksheet and click OK.  

Excel adds an empty PivotChart to the same worksheet that contains your Sales by Channel 
PivotTable. 

4. Select the empty PivotChart and in the PivotChart Tools tab, select Design and then Change Chart 
Type. 

5. Select the first chart in the Line group and then click OK. 
6. In the FactSales table, select the SalesAmount field. Ensure this field displays in the Values 

window of the Field List. 
7. In the DimChannel table, select the ChannelName field. In the PivotTable Field List, move this 

field from the Axis Fields box into the Legend Fields box. 
8. In the DimDate table, select CalendarQuarter. In the PivotTable Field List, move this field from 

the Values box into the Axis Fields box. 

The PivotChart and PivotTable now display the same data – in very different layouts. 

9. Format the display of the data to make it easier to read and compare. Right-click the axis 
numbers and select Format Axis.  

1. Click Number and in the Category list, select Currency. 
2. Set Decimal places to 0, and then click Close.  
3. Right-click the Sum of SalesAmount axis label and select Value Field Settings. 
4. Change Custom Name to Sales by Channel and then click OK. 

To Add Another PivotChart to Your Analysis 

1. Start on the worksheet that contains your Profit by Category PivotTable.  
2. On the PowerPivot tab in Excel, click the arrow below PivotTable and select PivotChart. 
3. Select Existing Worksheet and click OK.  

Excel adds an empty PivotChart to the same worksheet that contains your Profit by Category 
PivotTable. 

4. In the FactSales table, select the TotalProfit field. Ensure this field displays in the Values window 
of the Field List. 

5. In the ProductCategory table, select the ProductCategoryName field. Ensure this field displays in 
the Axis Fields window of the Field List. 

6. In the PivotChart Tools tab, select Design and click Change Chart Type. 
7. Scroll down and select the first Pie chart type and click OK. 
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8. In the Chart Styles group, select the 3-dimensional style with a black background and click OK. 
9. On your pie chart, select the title (Total) and change it to Profit % by Category. 
10. Next, you add and format data labels. 

1. On your pie chart, right-click and select Add Data Labels.  
2. Right-click again and select Format Data Labels.  
3. Highlight Label Options, then select the Percentage checkbox and deselect Value. 
4. Click Close. Resize the chart to make sure that all product categories are displayed. 
5. Resize the chart to make sure that all product categories are displayed. 

11. Save your PowerPivot workbook. 

Note 
This PivotChart displays percentage values for each product category. Because FactSales and other 
tables are filtered, the percentages are percentages of total sales in six of the eight categories of 
Contoso products. 

To Delete a PivotChart 

1. To delete a PivotChart, click inside the PivotChart. 
2. Right-click and select Cut.  

Deleting the PivotChart does not delete any associated PivotTable reports or data. 

To Add Slicers to the Profit by Category PivotTable 

1. Click anywhere inside the Profit by Category PivotTable to display the PowerPivot Field List. 
2. In the PivotTable Tools area of the Excel ribbon, click Options. 
3. Click Insert Slicer. 
4. In the Insert Slicers window, locate the Geography table and select RegionCountryName. 
5. Under the DimChannel table, select ChannelName. 
6. Under the ProductCategory table, select ProductCategoryName. 
7. Under the DimProductSubcategory table, select ProductSubcategoryName. 
8. Click OK. 

Format Slicers 
 

To Format Slicers 

1. Arrange the slicers so that they can all be seen. To move the Slicers, click the gray border and 
drag. 

2. The title of the ProductSubcategoryName Slicer is truncated. To format this Slicer, right-click the 
Slicer and select Slicer Settings. 

1. In the Caption box, type Subcategory. 
2. Verify that Display header is selected. 
3. Click OK. 

javascript:void(0)
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3. Sometimes Slicers must be resized in order to display their contents correctly. Resize the 
RegionCountryName Slicer by adding columns. 

1. Right-click the RegionCountryName Slicer and select Size and Properties. 
2. Highlight Position and Layout. 
3. In the Number of columns dropdown, select 4. Click Close. 
4. Drag the corners until all content is visible.  

4. Continue to format your Slicers as needed. 

Use Slicers to Analyze your PivotTable Data 
 

To Use Slicers to Analyze your PivotTable Data 

1. At Contoso we want to evaluate our sales profit trends by channel. Based on what we discover, 
we may have to redistribute marketing budgets and/or close channels. 

1. In the ChannelName Slicer, select Catalog. Catalog should now be the only shaded item in 
the Slicer list. 

2. By looking at the PivotTable you see that catalog sale profits are declining. 
3. One at a time, click Online, Reseller, and Store to reveal those profit trends. You see that 

online profits are increasing, store profits are decreasing and reseller profits are 
decreasing slightly. 

4. Clear the filters you have set by clicking the icon in the upper-right corner of the Slicer. 
2. Dig a bit further by slicing your profit data by subcategory and country. Here are several 

interesting things that you might discover: 
1. Profits have more than doubled for cellphone accessories, televisions, and recording pens 

with the biggest percentage increase coming from online sales. While most sales were 
made in stores, store profit percentage increase was the lowest. Given that most sales 
come from stores, what can be done to maximize profits from this channel? 

2. Cellphone accessories profits took a significant jump in 2009 for the Reseller and Store 
channels. Prior to that, profit increase was fairly flat in those 2 channels. To what can this 
jump be attributed? 

3. Overall profits from the sales of televisions more than doubled from 2007-2009. 
However, most of that increase came in 2008 with very little profit increase seen in 2009. 
Why were profits flat in 2009 and how can they be increased? 

4. Sales of Desktops dropped significantly. With total profits of almost 260 million, only 21 
million came from catalog sales. Catalog sales saw profits drop from almost 10 million 
(2007) to 4 million (2009). Perhaps Contoso should close this channel? 

5. Profits in Asian countries are increasing whereas profits in European countries, and North 
America are decreasing. 

Contoso can use this information, and much more, to make intelligent business decisions. 

To Add Slicers to a PivotChart 

1. Click anywhere inside the Profit % by Category PivotChart to display the PowerPivot Field List. 
2. In the PivotChart Tools area of the Excel ribbon, click Analyze. 
3. Click Insert Slicer. 

javascript:void(0)
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4. In the Insert Slicers window, locate the DimDate table and select CalendarYear and 
CalendarMonth. 

5. Under the Geography table, select RegionCountryName.  
6. Click OK. 

To Format Slicers 

1. Arrange the Slicers so that they can all be seen. To move the Slicers, click the gray border and 
drag the Slicers. 

2. Sometimes Slicers must be resized in order to display their contents correctly. 
1. Select the CalendarYear Slicer and resize it so that only 2007, 2008, and 2009 are 

displayed. 
2. Right-click RegionCountryName and select Size and Properties. 
3. Highlight Position and Layout. 
4. In the Number of columns dropdown, select 6. Click Close. 

3. By default, Slicer items are displayed in alphabetical and numeric order, with items with no data 
displayed last. To change this view: 

1. Right-click the CalendarMonth Slicer, and select Slicer Settings. 
2. Uncheck Show items with no data last. Click OK. 

4. Continue to format your Slicers as needed. 

To Use Slicers to Analyze your PivotChart Data 

1. Use the CalendarYear Slicer to explore profit by year. The PivotChart clearly shows the profit 
share increase for COMPUTERS and TV and VIDEO (at the expense of CAMERAS and 
CAMCORDERS) from 2007 to 2009. Profit share for the other categories shows almost no 
fluctuation. 

2. To dig even deeper, use the CalendarMonth Slicer. You will discover that CAMERAS and 
CAMCORDERS had the highest profit share in the latter months of 2007.  

3. Explore your data more by using the RegionCountryName Slicer. Clicking through the countries 
reveals many interesting facts. 

Contoso can use this information to make intelligent business decisions. 
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